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~ Introduction

 

Introductionto
LINKS Pro
Macintosh

 

Wiatcome to LINKS PRO for Macintosh! You’ve just bought the Mac

version of the extremely popular and award-winning LINKS 386 PRO golf

program — the finest golf simulator available on any personal computer.

Because LINKS PRO for Macintosh is designed to make full use of your

Mac’s capabilities, the hardware requirements (which are listed later in this

chapter) are quite stringent — but when you play it, you’ll see why. Whether

you are a novice, or an experienced golfer, you will find that the LINKS PRO

for Macintosh experience is rivaled only by an actual day on the course.

Here are just a few of the features that make LINKS for Macintosh so special:

¢ Female and male golfers, with 10 different shirt colors to choose from

¢ Eight different viewing windows, which can be arranged in over 300

different combinations

¢ Spectacular terrain texturing for realistic fairways, rough, sand, water, and

more

¢ The unique Record Game feature, which lets you record a game, then play

against yourself — or send the recorded game to a friend. Several pre-

recorded games are included.

* Statistics are recorded for each player and game, and can be printed out.

* Statistics for each championship course, to help you understand and play the

courses more effectively

¢ Saved Shot feature lets you save and replay your best shots

Reverse view of the green — available at all times, allowing you to watch

LINKS PRO MACINTOSH Players Manual 5
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your approach shot from the front and the back while it happens.

* Profile view shows all the changes in elevation between the ball and the pin

* Top view can be displayed in different sizes

* Club Selection Chart shows all the average club distances, and can remain on

the screen while you play

* Custom Shot Setup viewing window lets you set up special customized shots

* Realistic sound effects

* Network play over AppleTalk™ or most other local networks.

* Play world-famous Harbour Town Golf Links — and other world-class

courses sold separately as add-on disks.

About this Manual

This manual has been organized to help you find the information or

instructions you need easily and quickly. You'll get more out of the game if
you read the entire manual before playing the game. (If you’re really eager to

get started, at least review Chapters 1, 2, and 3.)

Additional Championship Courses

We are preparing to release new Mac versions of other championship courses.

Be sure to send in your registration card, so we can notify you as soon as the

new courses are available. For more information, call:

Access Software Inc.

800/800-4800 (toll-free, U.S. and Canada)

801/359-2900 (main office)

801/596-9128 (24-hour FAX)

Our regular business hours are Monday through Friday from 9:00 am to 5:00

p.m., Mountain Time.

6 LINKS PRO MACINTOSH Players Manual
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GettingStarted
 

The first step in using LINKS PRO for Macintosh is to get it onto your hard
disk. This chapter tells you about the game’s hardware requirements, and
shows you how to install it onto your computer.

Minimum Hardware Configuration
This program is designed to run on a Macintosh with the following minimum
configuration:

¢ 13” (or larger) 256-color monitor
¢4 megabytes of RAM (8 is recommended)
* System 6.07 or later (System 7 or later is recommended)
¢4 megabytes of free hard disk space

Installing LINKS PRO for Macintosh
LINKS PRO for Macintosh must be installed on a hard disk to operate
correctly. To install the game onto your hard disk:

1 Place LINKS program disk | in your disk drive, and double-click to open

it onscreen.

2 Double-click the Installer icon. Follow the onscreen instructions that
appear from time to time during the installation process.

3 The installation program copies all the program files into a new LINKS
PRO folder on your hard disk. When the installation process is

finished, open this folder and double-click the LINKS PRO icon to
start a new game.

LINKS PRO for Macintosh is not copy protected.

Loading LINKS PRO for Macintosh from Your Hard Disk
Once LINKS PRO for Macintosh has been installed on your hard disk, it works
like any other Macintosh application. To load it, open the LINKS PRO file,
and double-click on the LINKS PRO icon.

LINKS PRO MACINTOSH Players Manual 7
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Notes:

Speech works best ifyou turn off
"Background Sounds" in the Links Pro Sound

Options dialog in.

*The PlainTalk "floating window" can get

drawn over ifyou leave it on top of the main

Links Pro screen, so try moving it to the

bottom edge of the screen.

Voice Recognition
If you have an AV capable Macintosh or a Power Macintosh with PlainTalk
installed, you can use voice commands to control club and shot selection in
Links Pro. To activate this feature do the following:

1 Drag the "Links Speech Macros" document from this folder into the

Extensions folder in your System Folder.

2 Restart your Mac.
3 Make sure Speech Recognition is turned on in the "Speech Setup" control

panel in the Control Panels folder.

Links Pro recognizes the following voice commands at the main golf screen.

Select 7 iron
Select 8 iron
Select 9 iron
Select pitching wedge
Select sand wedge

Select Driver |
Select Driver 2

Select 2 wood
Select 3 wood
Select 4 wood
Select 5 wood Select lob wedge

Select 6 wood Address the ball
Select 7 wood Hit a draw
Select 1 iron Hit the ball straight
Select 2 iron Hit a fade

Select 3 iron Chip the ball
Select 4 iron Putt the ball
Select 5 iron User |
Select 6 Iron User 2

The commands may be longer than necessary in some cases because the

Speech Recognition works better with longer phrases. If you are familiar with
the Speech Macro Editor you can change the phrases by editing the "Links
Speech Macros" file.

8 LINKS PRO MACINTOSH Players Manual
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ChapterTwo

In TheClubhouse
 

I, an actual game of golf, you start by deciding who will play, which course

you want to play, whether you want to play a full 18 holes or just the front or
back nine, which clubs you will use, which tees you will hit from, and the

options and rules which will be followed during the round.

This chapter briefly takes you through these same preparations. You'll learn
how to set up a new game, choose the players for a round, select a course, and

set the course conditions and rules.

Starting a New Game
To start a new game, choose New Game...from the File menu. This brings up

the first of a sequence of Start a New Game... windows. The rest of this
chapter gives you step-by-step instructions for using these windows to set up

your game.

Choosing Your Players
The first screen in the series is where you set up your player list. From this
window, you can choose existing players, or create new ones.

Adding A Golfer To the Player List
The Available Golfers list on the left side of the window contains all the

golfers you’ve already created, as well as those included with the program and

those you may have gotten from friends. Your final player list for a given
game can include up to eight golfers from a variety of sources.

To add golfers to the Player List for your new game:

1 Move to the Available Golfers list and click the golfer you wish to add.

2 Click the Add button. The player appears on the Player List, ready to go.

Three buttons appear at the bottom of the Available Golfers list: Normal,
Recorded, and Both. These let you view different lists of potential players:

* Check Normal to view all the previously created golfers.

LINKS PRO MACINTOSH Players Manual 9
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* Check Recorded to view all the recorded players in your Recorded Games

folder. One of LINKS PRO’s features allows you to record a single
player’s game ona certain course, then replay the game in
competition against other golfers. You’ll find a detailed discussion of
recorded players later in this chapter.

¢ Check Both to display both the Normal and Recorded golfers in the

Available Golfers list.

Removing A Golfer From The Player List
To removea player from the Player List:

1 Click the player’s name to select it, then

2 Click the Remove button. The player’s name returns to the Available
Golfers list.

Creating A New Golfer
To create a new player, change the characteristics of an existing player, or
delete a player from your disk, click the Create /Edit Golfers... button just
below the Player List. This takes you to the Create, Edit, or Delete a Golfer...
window.

To create an entirely new player from scratch, enter the settings that define the
new player’s characteristics:

1 Player Name — Click the New... button, and enter the name of the new
player. Click Create to move to the next step.

2 Clubs — Go to the Clubs box and choose the club set you want the player
to carry. A player may carry up to 13 clubs, plus a putter. To find out
more about the club choices, please see Chapter 3.

* To select a club, click the box next to the club name. An X appears

in the box.
* To deselect, click the box again. The X disappears.

3 Animation — To select your new player’s gender, go to the Animation
box and click the appropriate button.

4 Level — Click one of these buttons to select your player’s skill level:
Beginner, Amateur, or Pro.

5 Shirt Color — Click a color square to choose a shirt color for this player.

6 Tee Box — Click one of these four squares to indicate which tee this
player should use:
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¢ Black
* Blue
¢ White
¢ Red

7 Auto Grid — Click one of these three buttons if you want a light green grid
to appear automatically on the terrain whenever you come to the tee.

For more about the Grid feature, please see Chapter 4.

¢ On green

¢ Everywhere
* No auto grid

8 Chipping club — Drag down this menu to view the complete list of
chipping clubs available. To select one of these clubs, drag the

cursor to highlight it, then release the mouse button. For more about

chipping clubs, please turn to the discussion of clubs in Chapter 3.

9 Caddy — If you choose this option, LINKS PRO recommendsa club for
you before each shot. The recommended club may or may not be the

best club for your shot, depending on the lie of the ball, wind
strength and direction, and the elevation difference between the ball

and the pin. You are always free to accept this recommendation, or
choosea different club instead.

When you’ve chosen all the characteristics for your new golfer, click the OK
button at the bottom of the screen. This returns you to the Start a New
Game...screen, where your new player appears in the Available Golfers list.

Changing An Existing Player’s Settings
You can change any characteristics of an existing golfer at any time.

1 Select Create/Edit/Delete from the Players menu.

2 Select the player you want to edit from the Player List.

3 Make your changes, following the same procedure you used when you

created the golfer. A new shirt color? Closer tees? Fewer irons, more

woods? A gender change? Anything is possible....

4 When you’re done, click OK to record the changes. If you change your
mind and want to leave the player as is, click Cancel.

LINKS PRO MACINTOSH Players Manual 11
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Options: —
[o Allow gimmies [J Allow mulligans

  
 

About Recorded Players
The Recorded Player feature lets you record a game (that is, a specific player
on a specific course), and then insert the recorded game as a Player on the
Player List. Fun things you can do with this include:

¢ Play against yourself by replaying the recording, and then playing
alongside it in real time.

* Copy the recorded game file onto a disk, send it to a friend, and let him or
her play against you.

* Don’t look at the final score while recording. This suspense makes for an

exciting match against a computer opponent who plays a true game,

as opposed to a randomly-generated adversary.

We have included several games which were recorded by members of the
LINKS PRO team, so you can play against one or more of the duffers at

Access Software.

Recording A Player
To record a player’s game, click the Record Game checkbox in the second
Start a New Game... screen (see above) where you select the course and the

holes you want to play. This checkbox appears alongside those for each

golfer’s level, tee, shirt color, and caddy settings. Once you are into the round,
you cannot stop the recording feature unless you start a new game. You can
record some players, but not others, in the same game. Games recorded on one

course cannot be used on another course.

All recorded games must be played under identical game conditions.
Whenever you are recording a game, or using a recorded player, certain
settings and conditions are automatically selected:

¢ Pin positions are set for everyone who plays against that recorded game in
the future

¢ Wind conditions are changed to No Wind
¢ Green conditions are set to Normal
¢ Gimmies are not allowed

Other than this, recording a game is no different than playing a regular game.

At the end of the round, give your recorded game a name, and save it. You
are not required to save a recorded game.

Adding A Recorded Player to the Player List
You can add a recorded player to a round when you first set up a new game:

1 In the Start A New Game... menu, go to the Show Players: box and click

12 LINKS PRO MACINTOSH Players Manual
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Recorded. All the available recorded players appear in the Available
Golfers list.

2 Click the name of the recorded player you want to play against to highlight
it. Then, click Add to add it to the Player List.

3 Proceed with the new game setup process as outlined above. You can mix
recorded and created players in the same game.

When You’ve Chosen Your Player List...
Your completed player list can contain up to eight players. Once you’ve got a

complete list of players, return to the Start a New Game... screen and click the

OK button at the bottom right. It’s time to move on to the next step...

Choosing Your Course, Holes, and Play Options
Once you’ve decided who’s going to play, it’s time to decide where you'll go,

and which holes you’ll play once you get there. The next screen is where you
make these choices.

1 Choose your course from the Available Courses list. This list will grow as

you buy add-on course disks in the future. If the list is too long to be

seen all at once, use the scroll bar to the right of the box to move up

or down.

2 Choose which holes you’re going to play. Click the appropriate button to

choose the front nine (holes 1-9), the back nine (holes 10-18), or all
18 holes.

3 Set your course conditions. Click a button to choose the wind speed, and

another one for the condition of the greens.

Wind — Higher winds make your shots more random, and increase

the challenge.

Greens — Greens are usually softer due to dampness or humidity,
and are typically harder when dry. This affects way the ball bounces

and rolls when it lands on the green: the impact of the ball is

dampened ona soft green, while harder green may heighten the

impact. Also, the ball rolls more slowly on soft greens, and faster on

hard greens.

Choose between Soft, Normal, and Hard green conditions.

4 Set Player Options — You can changea player’s skill level, tee choice,

shirt color, and caddy preference from this screen. These changes

LINKS PRO MACINTOSH Players Manual 13
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are only temporary, and do not affect the golfer’s permanent

characteristics. To make permanent changes, see the instructions for
Editing an Existing Player earlier in this chapter.

Level, Tee, and Shirt Changes: Click the arrows on either side of a

characteristic to scroll through the options. The option that appears is

the one that will be used in this game.

Caddy: Click this check box to turn the Caddy option on or off. For
more about the caddy, please see the Clubs discussion in Chapter 3.

Record Game: Click this check box if you want to record this

player’s game for later replay.

5 Gimmies and Mulligans — Click the check boxes if you want to allow
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these options during the upcoming round.

Gimmies: When the ball is on the green and so close to the hole that

the putt would certainly be made, the golfer, to save time (or out of
frustration) may just add a stroke to his or her score and not actually

attempt the putt. Gimmies are commonly allowed in friendly play,

and are an option in LINKS PRO for Macintosh for players who are

on the green, within two feet of the hole, and want to avoid having to
wait to make an easy putt.

Mulligans: When you take a shot over and don’t count the first shot,

it’s called “taking a Mulligan.” Mulligans are not sanctioned by the

U.S. Golf Association, but are commonly allowed in friendly play.

LINKS PRO for Macintosh does not add mulligans to your score, but

the number of mulligans taken during a round are recorded on the

score card.

———~«,9|) Tee ff!
When all the settings on this screen are where you want them, you’re ready to

play! Click the OK button to start the round. The next chapter shows you
what you need to know to perform well on the green.

* Click the Cancel button to return to the previous Start a New Game...

screen.

* To find out how to save a game, or return to a saved game, please turn to

Chapter 5.
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ve and your fellow players have arrived at the starting tees on your chosen

course, and are ready to play! In LINKS PRO for Macintosh — as in the actual
game — you select the correct club, take a practice swing, aim your shot, and
then swing away. This chapter explains how to use the pre- and post-shot
control panels to accomplish each of these steps.

The Pre-Shot Control Panel
This control panel extends across the bottom of the screen most of the time
you're on the course. It contains everything you need to set up your shots, and

gives you important information about the status of the game.

 

 

Number of strokes over (+) Or Button to skip over the
under (-) Par for current player player scheduled to hit

Number of shots taken | Button to display Selected club Button to display
Cc so far on current hole | non-obtrusive grid | Rotate panel

Sea clean Button to display | Button to take Degrees view rotated
currently playing Player now hitting \ location of the flag | a gimmie from direction of pin

Current hole & Selected club
Par for the hole

Button to display
Distance of ball club selection panel
from the pin 2

  

Button to display ~ Biltfon 10 Start =

Display of currentShot Setup panel os | iButton to display gol swing Selectable ie of the ball with
Button to display Scorecard panel Swing Indicator shot types short description

top Yew Patel Button to display Button to display
Drop Ball panel —_ Profile panel

  

Basic Shot Information
The top left corner of the control panel gives you the basic information about
the upcoming shot:

¢ The course name

¢ The name of the onscreen player
¢ The hole currently being played
¢ The par score for this hole
¢ The number of shots taken by this player so far on this hole
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CHAPTER THREE—On the Tee

 

 

  

 

 

 

 

 

* The player’s over/under par score

* The distance between the ball’s current location and the pin.

Besides this information, there are 11 rectangular buttons in the control panel:

eight to the immediate right of the Swing Gauge, and three to the far right.
They’re your keys to everything that happens during the game.

Setup
Displays the Shot Setup. This is an advanced feature that lets you adjust the

position of the ball in relation to your feet, and customize the angle at which
the face of your club meets the ball. See Chapter 4 to learn how to set up a

custom shot.

Top
Brings up the Top View window, giving you a bird’s eye view of your position
on the course. There’s a complete discussion of the viewing windows in
Chapter 4.

Scores
Displays the Score Card. If you’d like an in-depth explanation of the Score

Card, turn to Chapter 4.

Drop
If your ball has landed in an unplayable area — a hazard, behinda tree, or on a

cart path — you can choose to “drop” (that is, re-position) it to a more
favorable location within two club lengths of its current spot. There is a one

stroke penalty for dropping, unless you’re dropping off a cart path.

Click this button to view the special control panel that allows you set up your
drop. (The Drop button also appears on the post-shot options screen after any

otherwise unplayable shot.) United States Golf Association rules state that

when you choose to drop from an unplayable lie, you must drop within two
club lengths of the original spot, and no closer to the hole. Off the cart path,
it’s one length, and no closer to the hole. If you decide to drop after hitting
into a water hazard, the ball should be placed as close as possible to the point

16 LINKS PRO MACINTOSH Players Manual



CHAPTER THREE—On the Tee
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where the ball entered the hazard, and no closer to the hole. To drop the ball:

1 Click the Drop button that appears in the main or post-shot control panel.

2 From the new buttons that appear in the control panel, choose the type of
drop you want:

* Select New Position — Choose a new spot within two club lengths of
the previous one. Move the cursor to place the ball-and-tee cursor on

the spot you’ve chosen for the ball’s new position. Click to set the

new position.
* Back Up 50 Feet — Moves the ball 50 feet back toward the spot you

last hit it.
* Return to Original Spot —Replace the ball in the spot it landed after

the last shot. 3 Click the Hit From Here button to lock in the new

drop position you’ve chosen, or Cancel to cancel the drop and return

to the game. (You can’t cancel if you’re dropping out of a hazard.)

Skip
Skip over the player scheduled to hit and let the next player hit. The skipped
player will get another chance after everyone else has had a turn.

Grid
Click this to cover the playing area with a light green grid. Many players find
this useful for reading the course terrain. The grid is discussed in greater detail
in Chapter 4.

Profile
Display the Profile viewing window, which gives you a cross-section of the

elevation changes between the ball’s current position and the hole.

Flag
This shows you where the flag is in relation to your current position. When
you click it, the flag moves up to the ball, then back to the hole.

Gimmie
Take a gimmie. For information on gimmies, see Chapter 2.

Rotate
Click this button to change the direction you face in the Main View screen. In
effect, you can turn any direction and take a look around you. (It’s particularly
useful if you’re trapped behind a tree and want to see where you’re headed.)
The Rotate feature is not for aiming: to do that, please refer to the Aiming
Your Shot discussion below. Here’s how it works:

1 Click the Rotate button in the control panel. A compass appears, and the

Rotate button changes to a Redraw button with two arrow buttons

LINKS PRO MACINTOSH Players Manual 17
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above it. Move the mouse pointer into the compass.

2 Drag the compass needle in the direction you want the golfer to rotate.
The number above the Redraw button is the degrees of rotation from
your current position. The arrow symbol displays the direction
you’re turning.

3 Click the Redraw button. This redraws the Main View viewing window,
facing in the new direction.

 

@ file tdi Players Stats Options Club

ae ; When you created your player, you selected as set of up to 13 clubs, plus a

putter, for that player to use. This limit on the number of clubs conforms to the
United States Golf Association rules, which state that no more than 13 clubs
are allowed to be carried during a round. The contents of your club bag appear
onscreen when you move the pointer over the Club button in the control panel.

The clubs in LINKS PRO for Macintosh fall into four groups: Drivers (D1,
D2); Woods (2W, etc.); Irons (II, etc.); and Wedges (PW, SW, LW).

 

  * Drivers — These clubs are normally used to tee off, since they’re capable
of hitting the longest drives. Because the club faces are very flat,
drivers hit the ball with the lowest trajectory of all the clubs. For
that reason, the ball will travel the farthest in the air, and roll longer
once it hits the ground.

* Woods — Like drivers, woods have relatively flat club faces, causing the

ball to fly farther with lower trajectory, and roll farther on the

ground. The 2 Wood has the flattest club face (though it’s not as flat
as the drivers’ faces) and the 7 Wood has the most angled club face,

resulting in higher loft.

* Irons — Irons have even more angled club faces, so they typically hit the

ball with a higher trajectory. Generally, this results in shorter
distances — though not always. For example, the 2 Iron and the 5

Wood will both hit the ball about 220-225 yards at the professional
level.

* Wedges — The three wedges—pitching, sand, and loft—are actually irons,
but they have extremely angled club faces. Because of this, wedges
hit the ball higher in the air, causing the ball to travel a shorter
distance in the air and roll less after it lands. Choose a wedge when
you’re close to a green, and want the ball to land there and stay put.

Place the cursor on the Club button to view the current player’s full list of
clubs. These are the clubs you chose for the player when he or she was created.
You cannot change the contents of the club bag during a round.
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The current club has a red button next to it. To choose another club, simply
click one of the green buttons.

To find the average distance for a specific club, place the cursor arrow on it.
The distance appears in red at the bottom of the list.

If you selected the Caddy option when you created your player, LINKS PRO
for Macintosh selects a club for you before each shot. Consider this advice
carefully: the suggested club may not always be the best club for your shot,
depending on factors such as the current lie of the ball, wind strength and

direction, or, the difference in elevation between the ball and the pin. You are

free to take the caddy’s advice, or choose a different club instead.

The Swing Button and Gauge
The Swing button and gauge are located in the center of the control panel, and

are used to execute the swing sequence. See Chapter Four, Playing the Game,
for specific directions on setting up and executing a swing.

Choosing A Shot Type
The eight small buttons to the right of the Swing Gauge allow you to choose

the type of shot you want to take:

¢ Address — Back away from the ball and take a practice swing
¢ Draw — Hook the ball slightly to the left
¢ Straight —Takea regular, full swing
¢ Fade — Slice the ball slightly to the right
* Chip — Takea shorter, more controlled swing. Usually used close

to the green.

¢ Putt — Putt. From the fringe of the green, you can click Putt instead of
Chip.

* User | — Use a custom shot that you have created with the Setup. For
more on creating custom shots, see Chapter 4.

* User 2 — Use a second custom shot that you have created with the Setup.

Click a blue button to select your shot. The button turns red when selected.

The Lie of the Ball
The Lie window in the lower-right corner of the control panel shows the

terrain on which the ball is currently sitting. You may encounter 16 different
terrain types:

Asphalt Dirt Lava Rough
Concrete Dormant Grass Mud Sand

Deep Grass Fairway Ocean Stream
Deep Rough Green Pine Needles Water
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Wind Gauge and Compass
The wind gauge and compass are displayed in the bottom right corner of the
control panel. The wind compass indicates the direction the wind is blowing in
relation to the golfer. The wind gauge shows the windspeed.

ae Aiming Your Shot
After you choose a club, you need to decide exactly where you want the ball to
go. LINKS PRO for Macintosh provides an onscreen aiming marker to
simplify the process. To aim your shot:

1 Move the pointer into the Main View window.
2 Hold down the mouse button to display the red-and-white striped aiming

marker. It resembles a flagpole.
3 Use the mouse to drag the marker in the direction you want to aim.
4 When the marker is positioned where you want the ball to go, release the

mouse button.

 

 

To check the position of aiming marker at any time, Option-click in the Main
View window.

Taking Your Swing
You know where you want the ball to go, and chosen the club that you think
will get it there. Now, it’s time to take your swing!

The swing sequence has three basic parts: press and hold the mouse button,
release the button, and click to take the shot. Let’s look at each part in detail:

1 Place the cursor arrow on the Swing button in the control panel. Press and

hold down the mouse button to start the swing.

2 When the yellow indicator within the swing gauge reaches the green line
at 12 o’clock, release the mouse button. A yellow line marks the

point where you release, and the yellow indicator continues on, into
the red area at the end of the swing gauge.

The point at which you release the mouse button determines the

power level of the swing. If you release before or on the 12 o’clock
mark, your swing will be softer and more controlled, making the

snap (the second part of the swing) more likely to be accurate. If
you release in the red area (after the 12 o’clock mark), your swing
will be more powerful than normal and your snap will need to be

almost perfect to avoid severely hooking or slicing the shot.

3 When the yellow indicator reaches the end of the red area at the top of the

swing gauge, it bounces back around. When it reaches the green line
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at 6 o'clock, click the mouse button. A second yellow line marks the

second release point.

The point at which you click here determines how straight the shot

will go. This is called the snap. If you click before the 6 o’clock
mark, the shot will hook to the left. If you click after it, the shot will
slice to the right. The severity of the hook or slice depends on both

how close you get to the 6 o’clock mark, and, how powerfully you

swing. The more powerful the swing, the greater the hook or slice.

The Post-Shot Control Panel
After each shot, the control panel displays a different set of buttons and

information. The name of the current player appears in the top-left corner of
the control panel, along with the number of shots he or she has taken so far on

the current hole.

Shot Information
Under the player’s name is the shot information:

¢ In Air — The distance the ball traveled before it hit the ground
¢ Total — The total distance the ball traveled, both in the air and on the

ground
* To Pin — The distance between the ball’s new location and the pin.

To the right of the shot information is a box that gives you more information
about your ball’s new location, and any special options or penalties that apply
to your current situation.

The upper right corner of the control panel shows you who is Next To Hit. To
the right of that player’s name, you’ll see which club this golfer chose for his

or her previous shot. Under the player’s name is the current lie of the ball. In
addition, these five buttons always appear in the post-shot control panel:

* Save Shot —Record the shot just taken. This is discussed in greater detail

on the next page.

¢ Forward — View an instant replay of the shot from the spot where the

golfer hit the ball.
¢ Reverse — View an instant replay of the shot from the spot where the ball

came to rest.

¢ Skip — Skip the player who is supposed to hit next.

¢ View Panel — View the control panel.

These buttons also appear when appropriate:
* Mulligan — When mulligans are a game option, this button appears. Click

it to take the mulligan.
¢ Gimmie — When gimmies are a game option, and you are on the green,

within two feet of the hole, click this button to take the gimmie.
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NOTE: You cannot view a saved shot while

you’re playing a round. Ifyou try to do so, a

message warns you that the game will be

terminated ifyou view the saved shot, and

asks ifyou want to proceed. Click Yes to view

the saved shot, or No to return to the game in

progress.
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¢ Rehit — After the ball is hit into a hazard or out of bounds, click this
button to take the shot over. There is a one-stroke penalty for this.

¢ Drop — After the ball is hit into a hazard, click this button to move the
ball to another location within a two-club-length radius. There is a

one-stroke penalty for this.
* Continue — Click this button to continue the game. This button doesn’t

appear when the ball is hit out of bounds or into a hazard.

Saving a Shot
You tee off on a 172- yard par 3, get a good bounce, and watch the ball roll
into the dead center of the cup — your first hole-in-one! Unfortunately,
there’s nobody around to appreciate your incredible shot.

The Save Shot feature was designed for situations just like this. It allows you
to save all your best shots and replay them at any time. To save a shot:

1 After the ball has come to rest, the Post Shot control panel is displayed.
Click the Save Shot button in the lower-left corner of the control
panel. This brings up the Save Shot screen.

2 Click in the Filename box, and type in a name for the saved shot. Or, click
one of the names in the Shot List box to save the new shot under an

older name. The new shot will overwrite the old one.

3 Click OK to save the shot and return to the game. Click Cancel if you
decide not to save the shot.

Viewing a Saved Shot
To view a saved shot, use the View Saved Shot screen.

1 Select View Saved Shot from the File menu.

2 Find the saved shot you want to view in the menu that appears. Click on it
to highlight it, and then click Open.

3 When the replay is over, click Continue to return to the View Saved Shot
screen. You may choose to view the shot again, view a different
saved shot, or click Cancel to return to the menu.
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Links PRO for Macintosh contains quite a few features that enhance the

golfing experience, and make it more fun to play. This chapter covers these

options. It talks about:

¢ The score card

¢ Displaying the onscreen grid
¢ Player and course statistics
¢ Viewing the game through multiple windows
* Setting up a practice game

¢ A variety of graphics and sound options

* Creating custom shots

¢ Network play

 tee — Viewing and Printing the Score Card
The Score Card displays the players’ names, playing levels, over/under par

scores, and scores for each hole, along with other standard score card

information:
¢ The Out total (the number of shots taken on the front nine)

¢ The In total (the number of shots taken on the back nine)
¢ The Total number of shots taken on all 18 holes.

¢ The number of mulligans and gimmies taken by each player.
* The distances from the different tee boxes to the pin on each hole

¢ The par and handicap numbers for each hole.

 

  

Viewing the Score Card
* Click the Scores button in the control panel, OR
* Add the Score Card viewing window to your screen template, so you can

sae ne : z seen it all the time. There’s information on choosing viewing
QUS Legal O85 Letter Cancel
No. 10 Envelope

entation Sze"@ 100% —_CIt¥atages si windows later in this chapter.
Bitent smoothing

 

 

 

050%

Printing the Score Card
*Click the Print button while the Score Card is on screen. Your printer must

be hooked up, turned on, and ready to print.
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Viewing and Printing Statistics Screens
LINKS PRO for Macintosh compiles and records three different sets of
detailed and comprehensive statistics. The complete list of all statistics appears

in Appendix A. They fall into three categories:
MICHAEL JONES. |

¢ Player Statistics — The statistics for individual players.

  * Course Statistics:— The statistics for an individual course. No statistics

available until you have played the course at least once; each time
you play, the statistics are updated. Eighteen different course

statistics are recorded for every hole.

 

 

Be ab Course Statistics for Bountiful Municipal Golf Cours

our Rounds played:5
Course List Front

} (amtinsemeF | a te eee —) cas) ee * Game Statistics — These statistics appear immediately after a round is

= be completed, summarizing the statistics generated by the players
during the round. There are 25 game statistics for each player that

participates in a round.
  

If you have a printer, you can print out the game stats.
   

To View and Print Player Statistics
1 Select Player Stats from the Stats menu.

 

Cavesat focateco : a 2 From the Golfer List, select the golfer whose stats you want to see.
Hole our Rounds played:5

5. ont2
7 15

=k) ie 3 To print the stats for the selected player, click Print... at the bottom of the

window. You must be connected to a printer, and the printer must be

turned on and set up to print.

 

 

Womosanaacsonas

la

Tececsspeucsons

ae

 

           
4 Click OK to leave the Player Stats...window and return to the game.

 

 

To View and Print Course and Game Statistics
1 Select Course Stats from the Stats menu.

   

2 From the Course List, select the course whose stats you want to see.

3 To print the stats for the selected player, click Print... at the bottom of the

window. You must be connected to a printer, and the printer must be

turned on and set up to print.

4 Click OK to leave the Course Stats...window and return to the game.

Using Statistics to Improve Your Game
As you become familiar with LINKS PRO for Macintosh, the in-depth array of
statistics recorded by the game can give you valuable information that can help
you improve your game.
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The great thing about statistics is that they are based on actual results. By
looking at various elements of your game, you can identify the areas where
you have the greatest opportunity for improvement. Here are some examples:

¢ Print the statistics from your most recent game. Note the holes in which
you were over par; then use the Practice option on the File menu to

repeat those holes until you’ve mastered them. You may also review
the average score for each hole on a particular course and identify
those which give you the greatest challenge. Go to the Course Stats

area under the Stats menu and select the course you want to work on.

¢ Monitor these Player Stats:

% of Drives on Fairway—Your optimum percentage should be close

to 100%.

% of Greens in Regulation—Your optimum percentage should be

close to 100%.

3 Par Distance to Pin—Keep this number as small as you can, and

your birdie percentage should increase.

Average Strokes Taken—Keep this statistic close to or under par.

 

Setting Up A Practice Game
There is no separate driving range or chipping and putting green in LINKS
PRO for Macintosh. Instead, you can practice any hole on any course you
have loaded. This allows you to become very familiar with your favorite
courses, and improve your play by practicing in the specific areas that give you
trouble. You can also practice your driving off any tee, and your chipping and

putting on or around any of the greens. Here’s how to set up a practice round:

 

arbour Lown 1 From the File menu, select Practice Game.

  

2 The first Practice screen, which is almost identical to the first Start a New
Game screen, appears. You may practice with up to eight players.

Transfer these names to the Player List box.

3 When all the players are listed, click OK. (If you decide not to practice,

click Cancel button to leave the Practice Game sequence.)

4 A second Practice screen appears. Click the name of the course you want
to play in the Course List.

5 Click the number of the hole you want to practice.
exeveun-

|Os0-

6 Check the player settings — the Level, Tee, Shirt Color, and Caddy —
and make any desired changes. Choose whether or not to allow

q aa -Par <4 1th bic at Eiarbour Lown  
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mulligans or gimmies. Check the Course Conditions.

7 Click OK to go to the selected practice hole. Click Cancel to close the

Practice Game window without setting up a practice game.

After you finish the practice hole, the second Practice screen reappears, so you
may then choose another hole to practice.

 

Setting Up Custom Shots
LINKS PRO for Macintosh allows you to set up two custom shots per club, for
situations whena special shot is called for. By adjusting the stance, ball
position, swing plane, and club face angle, you can change the loft of the ball
to get more altitude, or, the spin of the ball to intentionally hook or slice.

As in the actual game, custom shots are designed to be used by experienced
golfers, who understand the dynamics of the golf swing. If you are unsure

 

 

about using the Setup, we recommend that you use the standard shot types, and

avoid making changes to the settings.

You can get to the Setup viewing window in two ways: Add the Setup
viewing window to the screen arrangement (for instructions, see Chapter 5), or,
click Setup in the control panel. The changeable settings include:

¢ Swing Plane — In the bar across the top of the Setup window, click the left
or right button to change the path of the club during the swing.

¢ Ball Position — In the bar just to the right of the foot marks, click the Up
or Down buttons to move the ball ahead or backwards in relation to
the golfer’s stance.

¢ Club Face — In the bar to the right of the Ball Position bar, click the Up or
Down button to change the angle at which the club face will be when

it meets the ball.

¢ Stance — In the bar below the foot marks, click the left button to open the

stance, or the right button to close the stance.

Set ups are for one kind of club, for one kind of shot. Check the Temporary
checkbox in the lower left corner to make the adjustments for the next shot
only. If you don’t check this box, the new settings will be a permanent part of
that club’s characteristics.

Click the Default on the lower right to return the club and shot to their original
values.
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Displaying the Grid
LINKS PRO for Macintosh offers a grid feature that’s useful when you need

help reading the terrain on the course. When you select this feature, a light
green grid covers the terrain in the Main View window. The grid may be used

anywhere on the course, but it’s most useful on the greens.

To display the grid, simply click the Grid button in the control panel before
taking your shot.

Using the Auto-Grid
You can ask LINKS PRO to turn the grid on automatically whenever it’s your
turn. This information becomes part of an individual player’s personal settings.
To add the Auto-Grid to a player’s settings:

1 Go to the Menu, and select Create/Edit/Delete from the Players menu.

2 Click the name of the player to whose settings you want to add the Auto-
Grid.

3 Find Auto-Grid under the Animation List box. Click in the checkbox to
select one of the three options:
¢ On Green— The grid appears automatically whenever you are on

the green

¢ Everywhere — the grid appears automatically, everywhere on the

course, during your turn.
¢ No Auto Grid—The grid never comes on automatically. You can

still turn it on manually from the control panel.

4 Click Save to make the Auto-Grid option permanent.

Changing Grid Sizes
Finally, you can also choose from two different grid sizes. To change the size:

1 Go to the Options menu and select Display Options .

2 Under Grid Size, click the Large or Small button to select your preferred
grid size.

3 Click OK to return to the game.

Window Layouts
Not only does LINKS PRO for Macintosh give you eight different viewing
windows through which you can watch you game unfold — it also lets you
watch the same shot through up to four screens at one time. You can fill the

entire screen with the Main View, put a second screen nearby in a split-screen
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setup, or arrange a quad-view screen that displays the Main View plus three
other viewing windows. It’s all up to you. The eight viewing windows include:

Layout.

rea) | es [ee/ de es ;

1 Main View — The Main View is the only window that must appear at all
times, since it’s the viewing window in which the golfer appears and

the swing action is executed. All the other viewing windows are

optional.
 

 

The Main View window can appear two different ways:

 

 

¢ Normal — standard scale

¢ Small — a wide-angle view in which the golfer appears at half the
size of the golfer in Normal mode. The advantage of the “small”
mode is that more of the area around the golfer is displayed, making
for a more open and panoramic view.

To change the Main Screen viewing mode:

1 Go to the Options menu at the top of the screen, and select
Window Layout.

2 Drag out the Main (Normal) menu bar at the center of the screen,

and select Main (Small).

3 Click OK to return the Main Screen.

To return to the Normal viewing mode, repeat the above process, selecting
Main (Normal) in Step 2.

2 Green View — This unique viewing window displays the view from
behind the green, facing back towards the tee, and allows you to see

your approach shots more clearly. Like Main View, Green View can

be viewed in normal or small mode.

3 Top View — This bird’s eye view of the course lets you see the position of
your ball in relation to the green, fairway, pin, and so on. Click and

hold the left mouse button to drag the Top View around within the

window. Option-click in the Top View viewing window to check the

distances from the ball to the cursor and from the cursor to the pin.

There are seven buttons along the left edge of the Top View viewing
window. Use the top two buttons to increase or decrease the
magnification of the area currently displayed in the Top View. The
next four allow you to move the view left or right, and up or down,
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to see other areas which are not currently visible. The R_ button at

the bottom will return the Top View to its original position and

magnification.

4 Setup — The Setup viewing window allows you to change the swing

plane, the golfer’s stance, the position of the ball, and the club face

angle. For directions on how to use the Setup to create a custom

shot, see Setting Up A Custom Shot, earlier in this chapter.

5 Club Distance — This chart show the average distance each club will hit
the ball at the beginner, amateur, and professional play levels.

6 Score Card — The Score Card includes the names of the players, their
levels, their over/under par scores, and their scores for each hole, as

well as other information typically found on a score card, including:

* The distances from the different tee boxes to the pin on each hole

¢ The par and handicap for each hole
¢ The number of strokes per hole for each player
¢ The number of mulligans and gimmies taken by each player

On the front of the Score Card is the Out total (the number of shots

taken on the front nine). On the back, you’ll find the In total (the

number of shots taken on the back nine), plus the grand Total for all

18 holes.

Click the Display Back/Display Front button at the lower right to

view the other side of the Score Card.

Click the Print button to print the Score Card. You must be

connected to a printer in order to do this. Make sure the printer is

turned on, connected properly, and that you have the appropriate

drivers installed.

7 Profile — This window shows cross-section of the course, so you can see

the elevation changes in the terrain between the ball’s starting
position and the pin. The flight of the ball is not shown in the Profile.

8 Blank — For whatever reason, you may want to have one viewscreen

blank. When you choose this, you’ll get a an empty black space.
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Positioning the Viewing Windows
The viewing windows in LINKS PRO for Macintosh can be viewed in one,

two, three, or four different sizes:

* Full size (entire screen)

¢ Vertical half (left or right half of the screen)

¢ Horizontal half (top or bottom half of the screen)

* Quarter screen (any quarter of the screen)

Some things to remember when you arrange your windows:
¢ In normal size, the Main View can be displayed full size, or as a vertical half.

In the small size, it can be displayed in any of the four options above.

¢ In normal size, the Green View can be viewed only as a vertical half. In
the small size, you can place it in a vertical half, horizontal half, or
quarter screen.

* Top View, Setup, Club Distance Chart, Score Card and Profile all can be

viewed as a vertical half, horizontal half, or quarter screen. These

windows cannot be viewed as full screens.

From one to four of these viewing windows may be seen at one time, and must
be arranged within one of the following six templates:

 

 View Layout:

 

    

You can rearrange the windows at any time, including during a game. To
arrange the viewing windows:

1 Select Window Layout... from the Options menu.

2 Six view layout templates appear at the top of the window. Click the view
layout template you'd like to use.

3 A bigger version of the template you chose appears under View Types:

below. In each of the windows of this template contains a menu. To
view a menu, place the cursor on it, and hold down the mouse

button. Drag to highlight the viewscreen you'd like to place in this

window, and release the button.

4 When you have finished choosing the arrangement, click OK to save the

arrangement and return to the menu. Click Cancel to leave the

Window Layout...window without changing the current layout.
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Game Options
From the Game Options window, you can change the following settings at any
time while a game is in progress:

¢ Wind conditions
¢ Green conditions
¢ Mulligans
¢ Gimmies

Choose Game Options from the Options menu to view this window. Then,
click the checkboxes of the options you want to change. Click OK to return to
the game, or Cancel leave the Game Options window without changing any
settings.

You cannot change the wind or green conditions if you are recording a game.

Sound Options
You can change LINKS’ sound effects at any time during the game.

From the Options menu, choose Sound Options. The sounds fall into four
categories:

* Background Sounds — Natural non-game sounds like birds, frogs, wind,
insects, and so on.

* Inflight Comments — Player comments made while the ball is in the air
* Post-shot Comments — Player comments made after the ball has landed
* Sound Effects — Game-related noises, such as the whoosh of a swinging club,

the plop as the ball hits the water, the thunk as it hits a tree, and so on.

To turn on a set of sound effects, click the checkbox next to it. When you’re
done, click OK to return to the game. Or, click Cancel to return to the game
without making any changes.

Display Options
In any computer simulation, there are trade-offs between high-speed gameplay
and high-quality graphics. In LINKS PRO for Macintosh, unlike most other
simulations, finding the right speed-to-beauty balance has been left to you.
You may choose to run LINKS PRO at the highest possible resolution, but find
that the program runs more slowly. Or, you may willing to trade some graphic
quality in order to make the program run as fast as possible.

The display options are one of the keys to finding this balance. Using these
options, you can display different screen elements in different resolutions at
the same time. For example, you may decide to sacrifice some resolution on
the clouds and distant skyline, and keep the foreground items in sharp focus.
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We encourage you to experiment, and find the combinations that work for you.

Before You Tweak The Graphics....
If you have less than eight megabytes of RAM in your Mac, we suggest you
try the following quick trick before you change the game’s display options:

| Return to the desktop, and select Restart from the Special menu.

2 After your Mac is completely off, and as the Restart process begins, press

and hold down the Shift key. Continue to hold it during the entire
restarting process. This deactivates all the accessory programs in
your System Folder that would otherwise launch during the startup

process, giving you extra memory to devote to LINKS PRO.

3 When the desktop reappears, release the Shift key and launch LINKS PRO.

If your Macintosh has four megabytes of RAM (the minimum needed to play
LINKS), you will probably need to follow this procedure every time in order to
load the game. If you have more RAM, this procedure is optional — but it
should buy you some extra speed.

Changing the Display Options
To reach the Display Options screen, go to the Options menu and select
Display Options. The screen that appears includes seven sections. To choose

any of the options in this window, simply click in the corresponding
checkboxes.

Bitmapped Panorama
The “panorama” includes distant images on the horizon, mountains and trees.

¢ Full Panorama — The best quality panorama, but also the most prone to

slow down the game’s speed.

¢ Compressed Panorama — A more chunky, less detailed rendering.

¢ No Panorama — Choose this to replace the panorama with blue sky. This

is the fastest option.

Bitmapped Objects
These commands control the rendering of the mid-ground and foreground
objects: trees, buildings, carts, and signs. It does NOT affect the rendering of
the greens, fairways, or hazards.

* No Compression — The best quality rendering. Very sharp and pretty, but
also the most likely to affect the computer’s speed.
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¢ Low Compression — Slightly blocky images — a small sacrifice of
quality.

¢ Medium Compression — More blocky than the above options.

* Max Compression — Very blocky objects, with very little detail. But it’s fast.

Drawing Detail
These settings changes the graphic quality of the course terrain. This terrain
falls into three areas:

¢ Close — Foreground terrain up to about 50 yards

¢ Mid — Mid-range terrain, from about 50 to 150 yards

¢ Far — Distant terrain, beyond 150 yards

For each of these areas, you can choose the rendering quality you prefer. Click
the MAX button to improve the graphic quality, MIN speed up the program,
or MED for a compromise between the two.

You may want to keep the Close area near the MAX setting, since it’s the

most visible area. A recommended speed configuration appears to the right of
these buttons.

Rendering
These settings allow you to gain speed by eliminating some rendering features.

¢ Draw shadows — When this is on, trees and other objects will cast realistic
shadows.

¢ Allow upscaling — When this is on, objects will scale upward, if needed, as

you get close to them. This may produce a more “blocky” appearance.

Grid Size
Click one of these buttons to choose the large or small grid option.

Drawing Options
These options let you control the detail level of the ground, the sky, and the

golf ball.

¢ Textures—Turn this on to see the thatch of greens, the waves in the pond,

and the grit in the sand traps. Turn off to make it faster.

* Clouds—Turn on this option to put clouds in the sky. Turn it off for a clear

blue sky—anda faster game.

¢ Large Ball—Turn this on to draw the ball larger when it’s in flight.
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Note: DO NOT turn Preload Course option
on unless you have at least 8 megs ofRAM.

Course Options
These two options let you manipulate the way your computer uses memory
during the game.

* Preload Course—If you select this option, LINKS PRO will load ALL the
course information into RAM at the start of the game. The loading
process will takea little longer at the start of the game, but you
should get this time back—with dividends—in faster gameplay.

* Verify File—This is a useful diagnostic of your game if it doesn’t seem to
be loading properly. When you turn on this option, LINKS will
double-check the course file for accuracy as it reads it into RAM
during the game.

The checking process does slow down the game, so be sure to turn this option
off when you’re not using it.

Default Settings
The Default button at the bottom of the Display Options screen instantly returns
the above options to their default settings — settings that we’ve found give us a
useful compromise between speed and detail. The default settings are:

Full Panorama No Compression
Close Detail — Max Mid Detail — Med
Far Detail — Min Draw Shadows
Allow Upscaling Small Grid
All drawing options ON All course options OFF

After you make adjustments to the game settings, click OK to return to the
game. If you decide not make adjustments, click Cancel. If you want to return
the settings to their original values, click Default.

Network Play
If you have an AppleTalk-based LocalTalk or Ethernet network, you can link
together up to eight players in a network game. (You can also play over a
modem with Apple Talk Remote Access, a software package available from
your Apple dealer.)

Here’s how to get a network game started:

I Install LINKS on each participating computer. You can have more than
one player on each computer. The network will support up to eight
computers and/or eight players.
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2 Select a host — the person who will set up the game. This person selects

Host Network Game from the File menu, and follows the directions
below to get things started.

3 Connect the remote players. These players select Join Network Game

from the File menu, and follow the directions below to join the host.

Recorded players may not be used in a network game.

All network games are played with no wind, and normal greens.

File/Host Network Game
As the host, this is the command you use to initiate the game. It’s very much
like the Start A New Game...screen described in Chapter 2.

| The first screen contains a Player List — which, at this point, contains just
the players available on the host machine. Select the golfers who will
be controlled from the host computer, and click OK.

2 Select a course from the list that appears, and click in the checkbox to

indicate whether mulligans will be allowed. When you’re done, click
OK.

3 LINKS PRO registers the game on the network. When the game is

registered, a new player list appears, showing which players — both
local and remote — have joined the game.

4 When all expected players appear on the Player List, click OK. The Select

Network Player Options screen appears, allowing each player to
select the shirt, tee, playing level, and caddy option for each player.

Players on the host machine can also opt to record their games by clicking
the Record Game checkbox.

5 When all the options are set, click OK to start game at first tee.

File/Join Network Game
If you’re not the host, here’s how you join a network game:

1 Select Join A Network Game from the File menu. The Start A New
Game...window appears, including a Player List. Select the players who will be

controlled from your machine. and click OK.

2 The Select Network Players Options window appears. Select the shirt color,
tee, playing level, and caddy options for each of the players who will be

controlled from your computer. You can also choose to record a player’s
game. Click OK when you’re done.
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3 LINKS PRO now searches the network for any network games that are open
to new players, and displays them onscreen in a list. Select the game you want,
and click OK.

Three buttons appear to the right of the list: Zones, Open/Join, and Cancel.
Large networks are divided into different regions (or zones), and your host
computer may be in a different zone. If this is the case, click Zone to view a
list of all the zones on your network. When you find the right one, highlight it,
and click Open to see the list of available games in that zone.

If you don’t see the game you're looking for, click Zones again to return to
zones list. When you find the game you want, highlight it, and click Join.

4 If the host computer isn’t ready, a message appears: Waiting for Host to Start
Game. Leave this message onscreen, and wait. When the host is ready, you’ll
be automatically brought into the game.

During Net Play
As the game unfolds, you'll see each player take his or her shot in turn, just as
you would in a replay of a recorded game. While you’re waiting for other
players to take their turns, a message appears at the top of the screen telling
you who’s up.

At the bottom of the screen, below control panel, there’s a window with a chat
area, sO you can trade comments. The chat window is live during the entire game.

* Incoming messages scroll by on the left side of the screen.
* The right side of the screen is the area where you type your comments.

Click the Send button or hit Enter (not Return!) to broadcast your
remarks.

Quitting A Network Game
Choose Quit from the File menu to leave a network game. A joining player can
simply drop out at any time, and the game will continue. When the host quits,
the game ends.
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This chapter covers basic file management and other software operations in
LINKS PRO for Macintosh. It deals with adding and removing players during
a round, saving games, deleting information, and (finally) quitting the game.

Adding or Removing Players During a Round
You may add players to a game in progress — and remove them as well — as

long as there are no more than eight golfers total.

To add a player to the current game:

1 In the Players menu, select Add/Remove In Current Game. The

Add/Remove In Current Game screen appears.

2 In the Available Golfers box, click the name of the player you want to add.

This transfers it to the Player List. To create a new golfer, click
Create Golfer..., and proceed according the directions on page ??.

3 Click OK to return to the game with your new player, or Cancel to return

to the game with the roster unchanged.

To remove a player from the current game:

1 In the Players menu, select Add/Remove In Current Game. The

Add/Remove In Current Game screen appears.

2 In the Player List, click the name of the player you want to remove. This
transfers it to the Available Golfers list.

3 Click OK to return to the game with your new player, or Cancel to return

to the game with the roster unchanged.

Saving a Game
If you’re in the middle of a round and need to quit — but you want to return to
the same game later — here’s how to save the game.

1 Go to the File menu and select Save Game.
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NOTE: Deleted players cannot be retrieved.

Don’t delete your golfers unless you’re

absolutely certain that you’re done with them!

2 Click in the Filename box, and type a name under which you want to save
this game.

3 Click Save to save the game and return to the menu. Click Cancel to
return to the menu without saving the game.

You cannot save a game that includes recorded players.

Resuming a Saved Game
To return to a previously saved game:

1 Go to the File menu and select Open Saved Game.

2 Select the game file you want to re-open from the menu that appears.
Double-click it, or highlight it and click Open.

Deleting A Player
It’s easy to delete saved games, courses and players that you’re no longer
interested in returning to:

1 Go to the Players menu and select Create/Edit/Delete....

2 In the file menu that appears, click on the name of the golfer you want to
delete.

3 Click the Delete button. A warning message appears. Click Delete to
complete the deletion, or Cancel to return to the game without
deleting the selected player.

Deleting a Recorded Player, Saved Shot, Game, or
Course
To delete any of these:

1 Go to the appropriate folder in your LINKS PRO game folder
2 Drag the file representing the player, shot, game, or course into the Trash Can
3 Empty the trash.

Quitting LINKS PRO for Macintosh
To leave the game at any time, simply go to the File menu and select Quit.
You will instantly return to the Finder.
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Player Statistics (Cumulative Totals)
¢ Number of Holes Played — All the holes you have played with your

player.
¢ Number of Rounds Played — Holes played divided by 18 (used for

average round stats).

* Average Score per Round — Average number of shots taken per 18 holes.

¢ # of Holes-in-One — Number of holes-in-one.
* Longest Drive (Fairway only) — The longest drive off the tee that landed

in the fairway.
* Average Drive (Fairways only) — Average of all drives that landed in the

fairway (D1 or D2).
* Total Drives in Fairway — Number of drives off the tee that landed in the

fairway (D1 or D2).
* % Drives in Fairway — Percentage of drives off the tee that landed in the

fairway (D1 or D2).

* Total Greens in Regulation — Number of times you reached a par 3 green

in one stroke; a par 4 green in two strokes or less; or, a par 5 green in
three strokes or less.

* % Greens in Regulation — Percentage of greens that you reached in
regulation.

* Average Putts per Round — Average number of putts taken per 18 holes.

* Avg. Putts/Hole (All Greens) — Average number of putts taken on all
greens you’ve played.

* Avg. Putts/Hole (Greens in Reg.) — Average number of putts on greens

reached in regulation.
* Total Number of Chip-Ins — Number of times you’ve hit the ball in the

LINKS PRO MACINTOSH Players Manual 39



APPENDIX A—Player, Course, and Game Statistics

 

hole not using the putter.
¢ Average Chip-Ins per Round — Average number of times you chip-in per

18 holes.

¢ 3-Par Distance to Pin — On par 3 holes, the average distance to the hole
after your first shot.

* Average Drops per Round — Average number of times you use the Drop
option per 18 holes.

¢ Average Rehits per Round — Average number of times you rehit per 18

holes.

¢ Average Mulligans per Round — Average number of mulligans taken per

18 holes.

¢ Average Strokes Taken

On Par 3s — Average number of shots needed to finish par 3 holes.

On Par 4s —Average number of shots needed to finish par 4 holes.

On Par 5s — Average number of shots needed to finish par 5 holes.

Individual Clubs
¢ Avg. Dist. — Average length of a shot using that club.
¢ % Hit Safe — Percentage of shots hit with that club that landed in the

fairway or on the green.

¢ Holed Out — Number of times the ball was hit into the hole using that
club.

 

Course Statistics
* Rounds Played — Number of times this course has been played.

¢ Handicap — (For information only) Difficulty rating of holes (low
numbers hardest).

¢ Yards (Back Tees) — Length of the hole for the tee furthest from the pin.
* Par — The number of shots officially deemed necessary to finish the hole.

    

¢ Average Score — Average number of shots needed to finish the hole.
# of Holes in One — Number of holes-in-one on this hole.

# of Dbl-Eagles — Number of times the hole has been finished three

strokes under par.

# of Eagles — Number of times the hole has been finished two
strokes under par.

# of Birdies — Number of times the hole has been finished one

stroke under par.

 

 
 

¢ % Birdies — Percentage of time players finish this hole one stroke under
par.

° % Pars — Percentage of time players finish this hole at par.

* % of Bogies — Percentage of time players finish this hole one stroke over par.

# of Dbl-Bogies — Number of times players finish this hole two
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strokes over par.

# ot Others — Number of times players finish this hole more than

two strokes over par.

¢ # of Chip-Ins — Number of times players have hit the ball in the hole not

using the putter.
¢ Avg. Putts (All Greens) — Average number of putts taken on this hole.

¢ Avg. Putts (Greens in Reg.) — Average number of putts after reaching the

green in regulation.
* % Drives in Fairway — Percentage of drives off the tee that landed in the

fairway.
¢ % Greens in Regulation — Percentage of time the green has been reached

in regulation.
* Average Drive (All) — Average of all drives off the tee using D1 or D2.

* Average Drive (Fairways only) — Average of all drives off the tee that

landed in the fairway using D1 or D2.

 Game Statistics
¢ Front 9 Par — Number of strokes officially deemed necessary to finish the

first nine holes.

es ¢ Back 9 Par — Number of strokes officially deemed necessary to finish the

© [Ei oes last nine holes.

* Total Par — Number of strokes officially deemed necessary to finish all 18

holes.
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     ¢ Player — The number corresponds to the “Player List” box.

¢ Number of Holes Played — Number of holes the player finished.
* Level — The player’s level during the round.

* Tees — The tee box from which the player hit during the round.

 

 
 

* Score Front 9 — Total number of strokes taken by the player for the first
nine holes.

* Score Back 9 — Total number of strokes taken by the player for the last

nine holes.

* Score Total — Total number of strokes taken by the player for all 18 holes.

¢ # of Holes in One — Number of holes-in-one hit by the player.

¢ # of Dbl-Eagles — Number of times the player finished a hole three

strokes under par.

¢ # of Eagles — Number of times the player finished a hole two strokes

under par.

¢ # of Birds — Number of times the player finished a hole one stroke under

par.

¢ # of Pars — Number of times the player finished a hole at even par.

¢ # of Dbl-Bogies — Number of times the player finished a hole two strokes

over par.
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¢ # of Others — Number of times the player finished a hole more than two
strokes over par.

* Longest Drive (Fairway only) — The longest drive off the tee that landed
in the fairway.

* Average Drive (Fairways only) — Average of all drives that landed in the
fairway.

* Total Drives in Fairway — Number of drives off the tee that landed in the
fairway.

* % Drives in Fairway — Percentage of drives off the tee that landed in the
fairway.

* Total Greens in Regulation — Number of times the player reached a par 3

green in one stroke, a par 4 green in two strokes or less, or a par 5

green in three strokes or less.

* % Greens in Regulation — Percentage of greens that the player reached in
regulation.

¢ Total Putts — Number of putts taken by the player during the round.
* Avg. Putts/Hole (All Greens) — Average number of putts taken on the

greens during the round.
* Avg. Putts/Hole (Greens in Reg.) — Average number of putts on greens

reached in regulation.

* Mulligans — Number of mulligans taken by the player during the round.
* Gimmies — Number of gimmies taken by the player during the round.
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This chapter answers some frequently-asked questions about LINKS PRO for
Macintosh, and includes our customer support and warranty information. To
save time (yours and ours) and phone charges, we encourage you to turn to this

chapter before calling us for help.

Q: How does the amount of available RAM affect game speed?

A: LINKS PRO will use up to about 8 MB RAM. If you have less, adding

more will speed up the program quite a bit. Of course, the program’s speed

also depends a great deal on the game settings. Raising the settings will
always slow the program, and lowering the settings will always increase the

speed of the program.

Q: Will I always see a noticeable difference in game speed when I turn
down the graphics settings?
A: Not always. If you have a fast machine with a lot of memory, changing the

graphics may not make a significant difference. If you have a slow computer

and/or not much memory, turning down the graphics settings should make a

noticeable difference in game speed.

Q: Why aren’t there more comments from female golfers in the sound
library?
A: The sound library is almost 1 MB and we felt that we couldn’t let it get any

larger. We'll try to do better on future libraries.

Q: What is the difference in strength between the female and male
golfers?
A: There is no difference, as long as both are playing at the same level (e.g.,

professional, amateur, or beginner).

Q: Will there ever be golfers of other races, or left-handed golfers
available in LINKS PRO?
A: Yes! We plan to offer a wide choice of golfers in LINKS PRO.

Registered owners will be notified as soon as they are available.

LINKS PRO MACINTOSH Players Manual 43



APPENDIX B—Frequently-Asked Questions

 

Q: In the post-shot control panel, the Skip button in the top-right corner
sometimes turns red. Why?
A: After you have skipped a player on the current hole, the next time he or she
is “next to hit,” the Skip button will be red. This is to remind you to skip the
player again if necessary. If you click the Continue button when the Skip
button is red, the player listed will hit after the screen draws.

Q: Why is the golfer not visible during a replay?
A: Displaying a reverse view of the golfer during replays requires significant
additional memory, which slows down game play. We are working on a

different method of storing animation images to allow reverse animations as

well as other animations. We hope these changes will be available in a later
version of LINKS PRO. If you call and register, we'll let you know when it’s
available.

Q: How many pin positions are there, and how are they determined?
A: There are six randomly-determined pin positions on each green. For
recorded games and players, there is only one default pin position, which is
always used.

Q: How does hitting off the different terrain affect the shot?
A: Each terrain type affects the shot distance differently. For example, hitting
out of the sand, or out of the deep rough, cuts the shot distance by
approximately 20%. Hitting off the short rough cuts the shot distance by
approximately 15%.

Q: Is there a way to capture a screen so I can use it in a paint program?
A: You can capture any LINKS PRO screen by pressing the Command-Shift-
3 keys simultaneously.

The screen will be saved to disk as Picture 1. Subsequent captures will be
saved as Picture 2, Picture 3, and so on. The file format is PICT and each
screen is 256K. The file can be converted to other popular formats such as

GIF,PCX,etc. using TeachText or any standard paint program.

Q: How do you choose which courses to produce?
A: We consider a number of factors:
1 Has the course hosted a PGA, Senior PGA, or LPGA event?
2 Is the course is listed in the Golf Digest annual course rankings?
3 Is it located in a popular golfing area? We want to offer courses from
different golf centers around the world — for example, the southeastern
Atlantic states (the Carolinas, Georgia, Florida, etc.), the Midwest), California,
Arizona, Hawaii, Canada, and Europe.
4 Does the course have distinctive character and unique challenges? Our PC
offerings have ranged from the traditional layout of Pinehurst #2, designed by
Donald Ross; to the modern layout of the Troon North desert course, designed
by Tom Weiskopf and Jay Moorish. We plan to add these courses and others to
our Macintosh course collection.
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Q: How do you produce the courses?
A: After receiving permission from the course owners, we obtain copies of the

course plans, topographical maps, and other pertinent information. We
videotape the entire course and surroundings, and take still photographs of the

trees, rocks, shrubs, buildings, and other objects on the course. We also take

hundreds of aerial photographs, which help us to correctly place the fairways,
bunkers, greens, hazards, and trees. This process takes five to ten days. Then,

over the next eight to ten weeks, the Access course construction team uses a

complex process to convert the information into a playable and extremely
realistic LINKS course.

Q: There are several courses which you have not done that are considered
to be among the most famous in the world. Do you plan to produce them
in the future?
A: We would like nothing more than to offer all of the finest championship

courses. Some courses, however, prefer to guard their privacy and have, so

far, not been receptive to our offers. We certainly hope to always produce the

best courses available, and that LINKS PRO users will be satisfied with our
selections. (The two most requested courses are Augusta National and Pebble

Beach. Neither has said yes. Yet!)

Q: Why does my caddy sometimes pick the wrong club?
A: The caddy selects a club based solely on the distance from the ball to the

pin and the lie of the ball, and does not take into account the difference in
elevation, wind strength and direction, or your style of play. The caddy
“recommends” a club, but you are free to choose another club at any time.

Q: When shouldI call the LINKS Technical Help Line?
A: When you are having a problem that you cannot solve on your own after
reading the manual thoroughly.

Calling LINKS Technical Support
For help with technical problems, call:

800/793-8324 (in the U.S. and Canada).

Hours are M-F 9 am-5 PM, Mountain Time
801-359-2900 (elsewhere)

In Europe, call US Gold Limited at 021-625-3366, or write them at:

Units 2/3 Holford Way
Holford, Birmingham B67AX England

Our technical support department will be able to answer your questions or
solve your problems most efficiently if you find out as much as you can about

your computer before you call. Please try to obtain the following information:
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* Your Mac’s model number
* The amount of RAM, and hard disk capacity
* Size and type of monitor
¢ The version of System you’re using.

To find most of this is information, return to the Finder and select About This
Macintosh... from the Apple menu.

Ordering From Access
To order any Access software product or to receive an updated product
brochure call us TOLL FREE at 1-800-800-4880. Or, you may FAX your
order to us at 801-359-2968.
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NOTICE: Access Software reserves the right
to make amendments or improvements to the

products described in the manual at any time

and without notice.

Access Software Product Warranty

The enclosed software product and this manual are copyrighted and all rights are reserved by

“Access Software, Incorporated.” No part of this manual or any of the accompanying materials

may be copied, reproduced, or translated in any form or medium without the prior written consent

of Access Software.

Access Software warrants to the original consumer purchaser that the diskettes furnished in

this product will be free from defects in materials and workmanship (as evidence by your receipt).

If any diskettes supplied as part of this product prove to be defective, and provided that the

consumer purchaser returns the media to Access Software, Inc. (in the U.S. and Canada) and U.S.

Gold Limited (in Europe) in accordance with the instructions in the following paragraph, Access

Software, Inc. or U.S. Gold Limited, will replace any defective diskettes free of charge. This

warranty is valid for 90 days following the purchase of this product (dated purchase receipt should

be retained).

To obtain a replacement diskette, please return the diskette only, postage prepaid to Access

Software, Inc. or U.S. Gold Limited at the address below, accompanied by a statement of the

defect, a copy of your purchase receipt, your name and return address.

DISCLAIMER NOTICE

The software diskettes and documentation are provided “as is”. There is not warranty of

merchantability, no warranty of fitness for a particular use, and no other warranty of any kind,

either expressed or implied regarding the software, diskettes or documentation, except as expressly

provided in the preceding paragraph. Accordingly, the entire risk as to the use, results and

performance of the software, diskettes and documentation is assumed by the user. In no event will
Access Software be liable to any person or organization for any consequential, special or indirect

damages resulting from possession, use, or malfunction of this product, including without

limitation, damage to property and to the extent permitted by law, damages for personal injury,

even if Access Software has been advised of the possibility of any such damages or loss.

Under this warranty the user agrees that the liability of Access Software arising out of any

kind of legal claim (whether in contract, tort, or otherwise) will not exceed the manufacturers

suggested retail price for the use of this product.

LINKS PRO and LINKS, The Challenge of Golf, are trademarks of Access Software, Inc. All
elements of this game and manual are copyright 1994, Access Software, Inc.. All rights reserved.

4910 West Amelia Earhart Drive, Salt Lake City, Utah 84116. Tel 801-359-2900 and are

distributed under license by U.S. Gold Limited, Units 2/3 Holford Way, Holford, Birmingham

B67AX. Tel 021 625 3366.
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The Swing Panel
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Aiming and Swinging Club Distances
To Aim Driver 4 D1 275yd
In the Main Viewing Window, drag the mouse Driver 2 D2 27Syd
in the direction you want to go. 2 Wood 2W 260yd

3 Wood 3W 250yd
When you click, the pointer changes to an Aiming 4 Wood 4W 235yd
Marker (a red and white pole) and the distance to 5 Wood SW 215yd
the marker from the location ofyour ball is displayed 6 Wood 6W 200yd
in the lower-right corner of the window. 7 Wood 7W 190yd

1 Iron 1 235yd
To swing | SWING | 2 Iron 2 220yd
1. Move the cursor over the word SWING. 3 Iron 3| 205yd

4 lron Al 195yd
2. Press and hold the left mouse button. This 5 lron 5l 185yd
starts the backswing. ~ 6 Iron 6 172yd

7 Iron 7\| 160yd
3. To start the forward swing, release the 8 lron 8l 148yd
button when the yellow indicator reaches the 9 Iron 9l 135yd
top. Pitching Wedge PW 120yd

F Sand Wedge SW 90ydIfyou release too soon, your swing has less power
but more control. Ifyou release too late, your swing Loft Wedge LW 70yd
has more power but less control. Distances are based on the following:

Ball hit from a tee, landing and rolling on fair-

bottom of the Swing gauge, press the left 10%less than Pro,ee ee ae ae eee
Note: With Driver 1, the ball will fly lower and

. : roll farther. With Driver 2, the ball will fly higher
Ifyou click too early, your shot will hook left. Ifyou and roll less.
click too late, your shot will slice to the right.
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